
Keyboard shortcuts for Word 

Hide All 

The shortcut keys described in this Help topic refer to the U.S. keyboard layout. Keys on other layouts may not correspond exactly to the keys on a U.S. 
keyboard. 

For keyboard shortcuts in which you press two or more keys simultaneously, the keys to press are separated by a plus sign (+) in Microsoft Word Help. 
For keyboard shortcuts in which you press one key immediately followed by another key, the keys to press are separated by a comma (,). 

To print this topic, press TAB to select Show All, press ENTER, and then press CTRL+P. 

Help task pane and Help window 

Using the Help task pane and Help window 

The Help task pane provides access to all Office Help content and appears as part of Microsoft Word. The Help window displays topics and other Help 
content and appears as a window next to, but separate from, Word. 

In the Help task pane 

In the Help window 

Menus, toolbars, task panes, and dialog boxes 

Access and use menus and toolbars 

To do this Press

Display the Help task pane. F1 

Switch between the Help task pane and Word. F6 

Select the next item in the Help task pane. TAB 

Select the previous item in the Help task pane. SHIFT+TAB 

Perform the action for the selected item. ENTER 

In a table of contents, select the next and previous item, respectively. DOWN ARROW and UP ARROW 

In a table of contents, expand and collapse the selected item, respectively. RIGHT ARROW and LEFT ARROW 

Move back to the previous task pane. ALT+LEFT ARROW 

Move forward to the next task pane. ALT+RIGHT ARROW 

Open the menu of task panes. CTRL+SPACEBAR 

Close and reopen the current task pane. CTRL+F1 

Expand a +/- list. RIGHT ARROW 

Collapse a +/- list. LEFT ARROW 

To do this Press

Select the next hidden text or hyperlink, or Show All or Hide All at the top of a topic. TAB 

Select the previous hidden text or hyperlink, or the Browser View button at the top of a Microsoft Office Web site 
article.  

SHIFT+TAB 

Perform the action for the selected Show All, Hide All, hidden text, or hyperlink. ENTER 

Move back to the previous Help topic. ALT+LEFT ARROW 

Move forward to the next Help topic. ALT+RIGHT ARROW 

Print the current Help topic. CONTROL+P 

Scroll small amounts up and down, respectively, within the currently displayed Help topic. 
UP ARROW AND DOWN 
ARROW 

Scroll larger amounts up and down, respectively, within the currently displayed Help topic. PAGE UP AND PAGE DOWN 

Change the Help window from being separate from (untiled) to connected to (tiled) Word. ALT+U 

Display a menu of commands for the Help window; requires that the Help window have active focus (click an item in the 
Help window). 

SHIFT+F10 
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 NOTE   You can use the keyboard to select any menu command on the menu bar. Press ALT to select the menu bar. Press the letter that is underlined in 
the menu name that contains the command you want. In the menu that appears, press the letter underlined in the command name that you want. 

Access and use task panes 

To do this Press

Select the menu bar (menu bar: The horizontal bar below the title bar that contains the names of menus. A menu bar can 
be the built-in menu bar or a custom menu bar.), or close an open menu and submenu at the same time. 

F10 or ALT 

Select a task pane or toolbar after pressing F10 or ALT to select the menu bar. Pressing the keys repeatedly moves the 
focus among the open toolbars, menu bars, and task pane. 

CTRL+TAB or 
CTRL+SHIFT+TAB 

When a toolbar (toolbar: A bar with buttons and options that you use to carry out commands. To display a toolbar, press 
ALT and then SHIFT+F10.) or menu bar is selected, select the next or previous button or menu. 

TAB or SHIFT+TAB 

Open the selected menu, or perform the action for the selected button or command. ENTER 

Display the shortcut menu (shortcut menu: A menu that shows a list of commands relevant to a particular item. To 
display a shortcut menu, right-click an item or press SHIFT+F10.) for the selected item. 

SHIFT+F10 

Display the title bar shortcut menu. ALT+SPACEBAR 

When a menu or submenu (submenu: A menu that appears when a user points to a command on a higher-level menu.) is 
open, select the next or previous command. 

DOWN ARROW or UP 
ARROW 

Select the menu to the left or right. When a submenu is open, switch between the main menu and the submenu. 
LEFT ARROW or RIGHT 
ARROW 

Select the first or last command on the menu or submenu. HOME or END 

Close an open menu. When a submenu is open, close only the submenu. ESC 

Open the selected menu. SHIFT+DOWN ARROW 

When a shortened menu is open, display the full set of commands. CTRL+DOWN ARROW 

Add a toolbar button to a menu. When you type this shortcut key and then click a toolbar button, Microsoft Word adds 

the button to the appropriate menu. For example, click Bullets  on the Formatting toolbar to add the Bullets 
command to the Format menu. 

ALT+CTRL+= (equal sign) 

Remove a command from a menu. When you type this shortcut key and then select a menu command, the command is 
removed. You can add the menu command back to the menu if you change your mind. 

ALT+CTRL+- (dash key) 

Customize the shortcut key for a menu command. When you type this shortcut key and then select a menu command, 
the Customize Keyboard dialog box opens so you can add, change, or remove the shortcut key. 

ALT+CTRL++ (plus key on 
numeric keypad) 

To do this Press

Open the task pane or hide the current task pane. CTRL+F1 

Move to a task pane (task pane: A window within an Office 
application that provides commonly used commands. Its location 
and small size allow you to use these commands while still 
working on your files.) from another pane in the program 
window. (You may need to press F6 more than once.) 

F6 

 NOTE   If pressing F6 doesn't display the task pane you want, try pressing ALT to 
place focus on the menu bar, and then pressing CTRL+TAB to move to the task 
pane. In addition, if you open a dialog box from the Reveal Formatting task pane, 
the focus may be in your document after you close the dialog box, rather than in the 
task pane. You can use F6 or CTRL+TAB to return to the task pane. 

When a menu or toolbar (toolbar: A bar with buttons and options 
that you use to carry out commands. To display a toolbar, press 
ALT and then SHIFT+F10.) is active, move to a task pane. (You 
may need to press CTRL+TAB more than once.) 

CTRL+TAB 

Open the menu of task panes. CTRL+SPACEBAR 

Go to the Getting Started task pane. ALT+HOME 

Reverse the sequence of task panes you opened. ALT+LEFT ARROW 

Repeat the sequence of task panes you opened. ALT+RIGHT ARROW 

Close a menu if one is currently open, or go back to the 
document. 

ESC 

When a task pane is active, select the next or previous option in 
the task pane. 

TAB or SHIFT+TAB 

Move among choices in a selected submenu; move among certain 
options in a group of options. 

DOWN ARROW or UP ARROW 

Open the selected menu, or perform the action assigned to the 
selected button. 

SPACEBAR or ENTER 

Open a shortcut menu (shortcut menu: A menu that shows a list 
of commands relevant to a particular item. To display a shortcut 
menu, right-click an item or press SHIFT+F10.) in a document; 
open a drop-down menu for the selected gallery item. 

SHIFT+F10 

When a menu or submenu is visible, select the first or last 
HOME or END 
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Resize and move toolbars, menus, and task panes 

1. Press ALT to select the menu bar (menu bar: The horizontal bar below the title bar that contains the names of menus. A menu bar can be the 
built-in menu bar or a custom menu bar.).  

2. Press CTRL+TAB repeatedly to select a toolbar (toolbar: A bar with buttons and options that you use to carry out commands. To display a 
toolbar, press ALT and then SHIFT+F10.) or the task pane (task pane: A window within an Office application that provides commonly used 
commands. Its location and small size allow you to use these commands while still working on your files.).  

3. Do one of the following: 

Resize a toolbar 

1. In the toolbar, press CTRL+SPACEBAR to display the Toolbar Options menu.  
2. Select the Size command, and then press ENTER.  
3. Use the arrow keys to resize the toolbar. Press CTRL+ the arrow keys to resize one pixel at a time.  

Move a toolbar 

1. In the toolbar, press CTRL+SPACEBAR to display the Toolbar Options menu.  
2. Select the Move command, and then press ENTER.  
3. Use the arrow keys to position the toolbar. Press CTRL+ the arrow keys to move one pixel at a time. To undock the toolbar, press 

DOWN ARROW repeatedly. To dock the toolbar vertically on the left or right side, press LEFT ARROW or RIGHT ARROW respectively 
when the toolbar is all the way to the left or right side.  

Resize a task pane 

1. In the task pane, press CTRL+SPACEBAR to display a menu of additional commands.  
2. Use the DOWN ARROW key to select the Size command, and then press ENTER.  
3. Use the arrow keys to resize the task pane. Use CTRL+ the arrow keys to resize by one pixel at a time.  

Move a task pane 

1. In the task pane, press CTRL+SPACEBAR to display a menu of additional commands.  
2. Use the DOWN ARROW key to select the Move command, and then press ENTER.  
3. Use the arrow keys to position the task pane. Use CTRL+ the arrow keys to move one pixel at a time. 

 NOTE    If you move the task pane up into the toolbars or down into the status bar, the pane attaches itself to the bars and reorients 
itself horizontally. To return the task pane to its vertical position, use the arrow keys to move it away from the bars. 

4. When you are finished moving or resizing, press ESC or ENTER.  

Use dialog boxes 

command on the menu or submenu. 

Scroll up or down in the selected gallery list. PAGE UP or PAGE DOWN 

Expand or collapse a collapsible item in the gallery list. CTRL+RIGHT ARROW or CTRL+LEFT ARROW 

Move to the top or bottom of the selected gallery list. CTRL+HOME or CTRL+END 

To do this Press

Move from an open dialog box back to the document for dialog boxes such as Find and Replace that support 
this behavior. 

ALT+F6 

Move to the next option or option group. TAB 

Move to the previous option or option group. SHIFT+TAB 

Switch to the next tab in a dialog box. CTRL+TAB 

Switch to the previous tab in a dialog box. CTRL+SHIFT+TAB 

Move between options in an open drop-down list, or between options in a group of options. Arrow keys 

Perform the action assigned to the selected button; check or clear the selected check box. SPACEBAR 

Open the list if it is closed and move to that option in the list. 
First letter of an option in a drop-down 
list 

Select an option; select or clear a check box. ALT+ the letter underlined in an option 

Open a selected drop-down list. ALT+DOWN ARROW 

Close a selected drop-down list; cancel a command and close a dialog box. ESC 

Run the selected command. ENTER 
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Use edit boxes within dialog boxes 

An edit box is a blank in which you type or paste an entry, such as your user name or the path (path: The route that the operating system uses to locate 
a folder or file; for example, C:\House finances\March.doc.) to a folder. 

Use the Open, Save As, and Insert Picture dialog boxes 

Quick reference 

Common tasks done in a Microsoft Word document 

To do this Press

Move to the beginning of the entry. HOME 

Move to the end of the entry. END 

Move one character to the left or right. LEFT ARROW or RIGHT ARROW 

Move one word to the left. CTRL+LEFT ARROW 

Move one word to the right. CTRL+RIGHT ARROW 

Select or unselect one character to the left. SHIFT+LEFT ARROW 

Select or unselect one character to the right. SHIFT+RIGHT ARROW 

Select or unselect one word to the left. CTRL+SHIFT+LEFT ARROW 

Select or unselect one word to the right. CTRL+SHIFT+RIGHT ARROW 

Select from the insertion point to the beginning of the entry. SHIFT+HOME 

Select from the insertion point to the end of the entry. SHIFT+END 

To do this Press

Display the Open dialog box. CTRL+F12 

Display the Save As dialog box. F12 

Go to the previous folder ( ). ALT+1 

Open the folder up one level from the open folder (Up One Level button ). ALT+2 

Close the dialog box and open your World Wide Web (World Wide Web (WWW): The multimedia branch of the Internet that presents not 
only text, but also graphics, sound, and video. On the Web, users can easily jump from item to item, page to page, or site to site by 

using hyperlinks.) search page (Search the Web button ). 

ALT+3 

Delete the selected folder or file (Delete button ). ALT+4 

Create a new subfolder in the open folder (Create New Folder button ). ALT+5 

Switch between List, Details, Properties, Preview Thumbnails, Tiles, and Icons views (click the arrow next to Views ). ALT+6 

Show the Tools menu (Tools button). 
ALT+7 or 
ALT+L 

Display a shortcut menu (shortcut menu: A menu that shows a list of commands relevant to a particular item. To display a shortcut 
menu, right-click an item or press SHIFT+F10.) for a selected item such as a folder or file. 

SHIFT+F10 

Move between options or areas in the dialog box. TAB 

Open the Look in or Save in list. F4 or ALT+I 

Update the files visible in the Open or Save As dialog box (File menu). F5 

To do this Press

Create a nonbreaking space. CTRL+SHIFT+SPACEBAR 

Create a nonbreaking hyphen. CTRL+HYPHEN 

Make letters bold. CTRL+B 

Make letters italic. CTRL+I 

Make letters underline. CTRL+U 

Decrease font size. CTRL+SHIFT+< 

Increase font size. CTRL+SHIFT+> 

Remove paragraph or character formatting. CTRL+SPACEBAR 

Copy the selected text or object. CTRL+C 

Cut the selected text or object. CTRL+X 
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Language bar 

Speech and handwriting recognition 

 NOTES  

� You can set the key combination for switching between languages or keyboard layouts in the Advanced Key Setting dialog box. To open the 
Advanced Key Setting dialog box, right-click the Language bar, and then click Settings. Under Preferences, click Key Settings.  

� The Windows logo key ( ) is available on the bottom row of keys on most keyboards.  

E-mail 

Sending e-mail messages 

Use the following keys (if you are e-mailing a document or a message) when the insertion point is in the e-mail header. To move the insertion point into 
the e-mail header, press SHIFT+TAB. 

Working with documents and Web pages 

Create, view, and save documents 

Paste text or an object. CTRL+V 

Undo the last action. CTRL+Z 

Redo the last action. CTRL+Y 

To do this Press

Switch between languages or keyboard layouts. Left ALT+SHIFT 

Switch microphone on or off. +V 

Switch between Voice Command mode and Dictation mode.  +T 

Display a list of correction alternatives.  +C 

Turn handwriting on or off.  +H 

Turn Japanese Input Method Editor (IME) (IME: A program that enters East Asian text (Traditional Chinese, Simplified Chinese, 
Japanese, or Korean) into programs by converting keystrokes into complex East Asian characters. The IME is treated as an alternate 
type of keyboard layout.) on 101 keyboard on or off. 

ALT+~ 

Turn Korean IME on 101 keyboard on or off. Right ALT 

Turn Chinese IME on 101 keyboard on or off. CTRL+SPACEBAR 

To do this Press

Send the active document (active document: The document in which you're working. Text you type or graphics you insert in Microsoft 
Word appear in the active document. The title bar of the active document is highlighted.) or message. 

ALT+S 

Open the Address Book. CTRL+SHIFT+B 

When the insertion point is in the message header, check the names on the To, Cc, and Bcc lines against the Address Book. 
ALT+K, 
CTRL+K 

Open the Address Book in the To field. ALT+. (period) 

When the insertion point is in the message header, open the Address Book in the Cc field. ALT+C 

If the Bcc field is visible, open the Address Book in the Bcc field. To display the Bcc field, open the Address Book for any field, and 
insert or type a name in the Bcc box. 

ALT+B 

Go to the Subject field. ALT+J 

Open the Microsoft Outlook Message Options dialog box. ALT+P 

Create a message flag. CTRL+SHIFT+G 

When the insertion point is in the message header, move to the next box in the e-mail header. When the last box in the e-mail header 
is active, TAB moves the insertion point to the body of the document or message. 

TAB 

Select the previous field or button in the e-mail header. SHIFT+TAB 

When the insertion point is in the message header, select the Send button. You can then use the arrow keys to move to the other 
buttons. To perform the action for the selected button or command, press ENTER. 

CTRL+TAB 
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Find, replace, and browse through text 

Undo and redo actions 

Switch to another view 

Outline view 

In outline view, press 

To do this Press

Create a new document of the same type as the current or most recent document. CTRL+N 

Open a document. CTRL+O 

Close a document. CTRL+W 

Split the document window. ALT+CTRL+S 

Remove the document window split. ALT+SHIFT+C 

Save a document. CTRL+S 

To do this Press

Find text, formatting, and special items. CTRL+F 

Repeat find (after closing Find and Replace window). ALT+CTRL+Y 

Replace text, specific formatting, and special items. CTRL+H 

Go to a page, bookmark, footnote, table, comment, graphic, or other location. CTRL+G 

Switch between documents or sections of a document, and between a document and an open e-mail message if you use Word as 
your e-mail editor. 

ALT+CTRL+Z 

Open a list of browse options; use the arrow keys to select an option, and then press ENTER to browse through a document by 
using the selected option. 

ALT+CTRL+HOME 

To do this Press

Cancel an action. ESC 

Undo an action. CTRL+Z 

Redo or repeat an action. CTRL+Y 

To do this Press

Switch to print layout view (Print Layout view: A view of a document or other object as it will appear when you print it. For example, 
items such as headers, footnotes, columns, and text boxes appear in their actual positions.). 

ALT+CTRL+P 

Switch to outline view (outline view: A view that shows the headings of a document indented to represent their level in the document's 
structure. You can also use outline view to work with master documents.). 

ALT+CTRL+O 

Switch to normal view (normal view: A view that shows text formatting and a simplified page layout. Normal view is convenient for most 
editing and formatting tasks.). 

ALT+CTRL+N 

Switch to Reading View. ALT+R 

Expand or collapse subdocuments in a master document. CTRL+\ 

To do this Press

Promote a paragraph. ALT+SHIFT+LEFT ARROW 

Demote a paragraph. ALT+SHIFT+RIGHT ARROW 

Demote to body text. CTRL+SHIFT+N 

Move selected paragraphs up. ALT+SHIFT+UP ARROW 

Move selected paragraphs down. ALT+SHIFT+DOWN ARROW 

Expand text under a heading. ALT+SHIFT+PLUS SIGN 

Collapse text under a heading. ALT+SHIFT+MINUS SIGN 

Expand or collapse all text or headings. ALT+SHIFT+A 

Hide or display character formatting. The slash (/) key on the numeric keypad 

Show the first line of body text or all body text. ALT+SHIFT+L 

Show all headings with the Heading 1 style. ALT+SHIFT+1 

Show all headings up to Heading n. ALT+SHIFT+n 

Insert a tab character. CTRL+TAB 
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Printing and previewing documents 

Reviewing documents 

Reading layout view 

References, footnotes, and endnotes 

Working with Web pages 

 NOTE   To use keys to go back or forward one page or to refresh a page, the Web toolbar must be showing. If the Web toolbar is not showing, press 
ALT, press V, press T, use the arrow keys to select Web, and then press ENTER. 

Editing and moving text and graphics 

Delete text and graphics 

To do this Press

Print a document. CTRL+P 

Switch in or out of print preview (print preview: A view of a document as it will appear when you print it.). ALT+CTRL+I 

Move around the preview page when zoomed in. Arrow keys 

Move by one preview page when zoomed out. PAGE UP or PAGE DOWN 

Move to the first preview page when zoomed out. CTRL+HOME 

Move to the last preview page when zoomed out. CTRL+END 

To do this Press

Insert a comment (comment: A note or annotation that an author or reviewer adds to a document. Microsoft Word displays the 
comment in a balloon in the margin of the document or in the Reviewing Pane.). 

ALT+CTRL+M 

Turn track changes (tracked change: A mark that shows where a deletion, insertion, or other editing change has been made in a 
document.) on or off. 

CTRL+SHIFT+E 

Close the Reviewing Pane if it is open. ALT+SHIFT+C 

To do this Press

Go to beginning of document. HOME 

Go to end of document. END 

Go to page number. Number, then ENTER 

Increase the size of selected text by one point. CTRL+] 

Decrease the size of selected text by one point. CTRL+[ 

Exit reading layout view. ESC 

To do this Press

Mark a table of contents entry. ALT+SHIFT+O 

Mark a table of authorities entry (citation). ALT+SHIFT+I 

Mark an index entry. ALT+SHIFT+X 

Insert a footnote. ALT+CTRL+F 

Insert an endnote. ALT+CTRL+D 

To do this Press

Insert a hyperlink (hyperlink: Colored and underlined text or a graphic that you click to go to a file, a location in a file, a Web page on 
the World Wide Web, or a Web page on an intranet. Hyperlinks can also go to newsgroups and to Gopher, Telnet, and FTP sites.). 

CTRL+K 

Go back one page. 
ALT+LEFT 
ARROW 

Go forward one page. 
ALT+RIGHT 
ARROW 

Refresh. F9 

To do this Press
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Copy and move text and graphics 

Insert special characters 

Insert characters by using character codes 

Delete one character to the left. BACKSPACE 

Delete one word to the left. CTRL+BACKSPACE 

Delete one character to the right. DELETE 

Delete one word to the right. CTRL+DELETE 

Cut selected text to the Office Clipboard. CTRL+X 

Undo the last action. CTRL+Z 

Cut to the Spike (Spike: A special AutoText entry that stores multiple deletions. Microsoft Word appends one item to another until 
you paste the contents as a group in a new location in your document. You can also use the Microsoft Office Clipboard to get the 
same result.). 

CTRL+F3 

To do this Press

Copy text or graphics. CTRL+C 

Display the Office Clipboard. CTRL+C, CTRL+C 

Move text or graphics. 
F2 (then move the insertion 
point and press ENTER) 

Create AutoText (AutoText: A storage location for text or graphics you want to use again, such as a standard contract 
clause or a long distribution list. Each selection of text or graphics is recorded as an AutoText entry and is assigned a 
unique name.). 

ALT+F3 

Paste the Office Clipboard contents. CTRL+V 

Paste the Spike (Spike: A special AutoText entry that stores multiple deletions. Microsoft Word appends one item to 
another until you paste the contents as a group in a new location in your document. You can also use the Microsoft 
Office Clipboard to get the same result.) contents. 

CTRL+SHIFT+F3 

Copy the header or footer used in the previous section of the document. ALT+SHIFT+R 

To do this Press

A field CTRL+F9 

An AutoText (AutoText: A storage location for text or graphics you want to use again, such as a 
standard contract clause or a long distribution list. Each selection of text or graphics is recorded as 
an AutoText entry and is assigned a unique name.) entry 

ENTER (after typing the first few characters of the 
AutoText entry name and when the ScreenTip 
appears) 

A line break SHIFT+ENTER 

A page break CTRL+ENTER 

A section break CTRL+SHIFT+ENTER 

An em dash ALT+CTRL+MINUS SIGN 

An en dash CTRL+MINUS SIGN 

An optional hyphen CTRL+HYPHEN 

A nonbreaking hyphen CTRL+SHIFT+HYPHEN 

A nonbreaking space CTRL+SHIFT+SPACEBAR 

The copyright symbol ALT+CTRL+C 

The registered trademark symbol ALT+CTRL+R 

The trademark symbol ALT+CTRL+T 

An ellipsis ALT+CTRL+PERIOD 

A single opening quotation mark CTRL+`, ` 

A single closing quotation mark CTRL+', ' 

Double opening quotation marks CTRL+`, SHIFT+' 

Double closing quotation marks CTRL+', SHIFT+' 

To do this Press

The Unicode character for the specified Unicode (hexadecimal) character code. For example, to insert the euro currency symbol (
), type 20AC, and then hold down the ALT key and press X. 

The character code, 
ALT+X 

The ANSI (ANSI character set: An 8-bit character set used by Microsoft Windows that allows you to represent up to 256 
characters (0 through 255) by using your keyboard. The ASCII character set is a subset of the ANSI set.) character for the 
specified ANSI (decimal) character code. For example, to insert the euro currency symbol, hold down the ALT key and press 0128 
on the numeric keypad. 

ALT+the character 
code (on the numeric 
keypad) 
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Select text and graphics 

Select text by holding down SHIFT and pressing the key that moves the insertion point. 

Select multiple areas that aren't next to each other 

After making your first selection, hold down CTRL, and then select any other items you want. 

Extend a selection 

Tip 

If you know the key combination to move the insertion point, you can generally select the text by using the same key combination while holding down 
SHIFT. For example, CTRL+RIGHT ARROW moves the insertion point to the next word, and CTRL+SHIFT+RIGHT ARROW selects the text from the 
insertion point to the beginning of the next word. 

Select text and graphics in a table 

Move the insertion point 

To do this Press

Turn extend mode on. F8 

Select the nearest character. F8, and then press LEFT ARROW or RIGHT ARROW 

Increase the size of a selection. F8 (press once to select a word, twice to select a sentence, and so on) 

Reduce the size of a selection. SHIFT+F8 

Turn extend mode off. ESC 

One character to the right SHIFT+RIGHT ARROW 

One character to the left SHIFT+LEFT ARROW 

To the end of a word CTRL+SHIFT+RIGHT ARROW 

To the beginning of a word CTRL+SHIFT+LEFT ARROW 

To the end of a line SHIFT+END 

To the beginning of a line SHIFT+HOME 

One line down SHIFT+DOWN ARROW 

One line up SHIFT+UP ARROW 

To the end of a paragraph CTRL+SHIFT+DOWN ARROW 

To the beginning of a paragraph CTRL+SHIFT+UP ARROW 

One screen down SHIFT+PAGE DOWN 

One screen up SHIFT+PAGE UP 

To the beginning of a document CTRL+SHIFT+HOME 

To the end of a document CTRL+SHIFT+END 

To the end of a window ALT+CTRL+SHIFT+PAGE DOWN 

To include the entire document CTRL+A 

A vertical block of text CTRL+SHIFT+F8, and then use the arrow keys; press ESC to cancel selection mode 

To a specific location in a document F8+arrow keys; press ESC to cancel selection mode 

To do this Press

Select the next cell's contents. TAB 

Select the preceding cell's 
contents. 

SHIFT+TAB 

Extend a selection to adjacent 
cells. 

Hold down SHIFT and press an arrow key repeatedly 

Select a column. 
Click in the column's top or bottom cell. Hold down SHIFT and press the UP ARROW or DOWN ARROW key 
repeatedly 

Extend a selection (or block). CTRL+SHIFT+F8, and then use the arrow keys; press ESC to cancel selection mode 

Remove the selection. SHIFT+F8 

Select an entire table. ALT+5 on the numeric keypad (with NUM LOCK off) 

To do this Press

Page 9 of 16Microsoft Office Online: Help and How-to: Keyboard shortcuts for Word

10/3/2007http://office.microsoft.com/assistance/hfws.aspx?AssetID=HP051866641033&CTT=1&Origin=EC0...



Move around in a table 

Insert paragraphs and tab characters in a table 

Character and paragraph formatting 

Copy formatting 

Change or resize the font 

One character to the left LEFT ARROW 

One character to the right RIGHT ARROW 

One word to the left CTRL+LEFT ARROW 

One word to the right CTRL+RIGHT ARROW 

One paragraph up CTRL+UP ARROW 

One paragraph down CTRL+DOWN ARROW 

One cell to the left (in a table) SHIFT+TAB 

One cell to the right (in a table) TAB 

Up one line UP ARROW 

Down one line DOWN ARROW 

To the end of a line END 

To the beginning of a line HOME 

To the top of the window ALT+CTRL+PAGE UP 

To the end of the window ALT+CTRL+PAGE DOWN 

Up one screen (scrolling) PAGE UP 

Down one screen (scrolling) PAGE DOWN 

To the top of the next page CTRL+PAGE DOWN 

To the top of the previous page CTRL+PAGE UP 

To the end of a document CTRL+END 

To the beginning of a document CTRL+HOME 

To a previous revision SHIFT+F5 

After opening a document, to the location it was in when the document was last closed SHIFT+F5 

To do this Press

Next cell in a row TAB 

Previous cell in a row SHIFT+TAB 

First cell in a row ALT+HOME 

Last cell in a row ALT+END 

First cell in a column ALT+PAGE UP 

Last cell in a column ALT+PAGE DOWN 

Previous row UP ARROW 

Next row DOWN ARROW 

To do this Press

New paragraphs in a cell ENTER 

Tab characters in a cell CTRL+TAB 

To do this Press

Copy formatting from text. CTRL+SHIFT+C 

Apply copied formatting to text. CTRL+SHIFT+V 

To do this Press

Change the font. CTRL+SHIFT+F 

Change the font size. CTRL+SHIFT+P 

Increase the font size. CTRL+SHIFT+> 

Decrease the font size. CTRL+SHIFT+< 
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Apply character formats 

View and copy text formats 

Set line spacing 

Align paragraphs 

Apply paragraph styles 

Increase the font size by 1 point. CTRL+] 

Decrease the font size by 1 point. CTRL+[ 

To do this Press

Change the formatting of characters (Font command, Format menu). CTRL+D 

Change the case of letters. SHIFT+F3 

Format letters as all capitals. CTRL+SHIFT+A 

Apply bold formatting. CTRL+B 

Apply an underline. CTRL+U 

Underline words but not spaces. CTRL+SHIFT+W 

Double-underline text. CTRL+SHIFT+D 

Apply hidden text formatting. CTRL+SHIFT+H 

Apply italic formatting. CTRL+I 

Format letters as small capitals. CTRL+SHIFT+K 

Apply subscript formatting (automatic spacing). CTRL+EQUAL SIGN 

Apply superscript formatting (automatic spacing). CTRL+SHIFT+PLUS SIGN 

Remove manual character formatting. CTRL+SPACEBAR 

Change the selection to the Symbol font. CTRL+SHIFT+Q 

To do this Press

Display nonprinting characters. CTRL+SHIFT+* (asterisk) 

Review text formatting. SHIFT+F1 (then click the text whose formatting you want to review) 

Copy formats. CTRL+SHIFT+C 

Paste formats. CTRL+SHIFT+V 

To do this Press

Single-space lines CTRL+1 

Double-space lines CTRL+2 

Set 1.5-line spacing CTRL+5 

Add or remove one line space preceding a paragraph CTRL+0 (zero) 

To do this Press

Center a paragraph. CTRL+E 

Justify a paragraph. CTRL+J 

Left align a paragraph. CTRL+L 

Right align a paragraph. CTRL+R 

Indent a paragraph from the left. CTRL+M 

Remove a paragraph indent from the left. CTRL+SHIFT+M 

Create a hanging indent. CTRL+T 

Reduce a hanging indent. CTRL+SHIFT+T 

Remove paragraph formatting. CTRL+Q 

To do this Press

Apply a style. CTRL+SHIFT+S 

Start AutoFormat. ALT+CTRL+K 

Apply the Normal style. CTRL+SHIFT+N 
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Drawing objects and other objects 

Inserting and editing objects 

Insert an object by using the keyboard. 

1. Use the keyboard to open the Object dialog box (Insert menu).  
2. Use the DOWN ARROW key to select an object, and then tab to OK, and press ENTER. 

Edit an object by using the keyboard. 

1. With the insertion point to the left of the object in your document, select the object by pressing SHIFT+RIGHT ARROW.  
2. Press SHIFT+F10.  
3. Tab to Object name Object, press ENTER, and then press ENTER again. 

Inserting and selecting drawing objects 

Insert an AutoShape by using the keyboard. 

1. Use the keyboard to show the Drawing toolbar if it is not showing.  
2. Press ALT+U to choose AutoShape on the Drawing toolbar.  
3. Use the arrow keys to move through the categories of AutoShapes (AutoText: A storage location for text or graphics you want to use again, 

such as a standard contract clause or a long distribution list. Each selection of text or graphics is recorded as an AutoText entry and is assigned 
a unique name.) and select the AutoShape you want.  

4. Press CTRL+ENTER.  

 NOTE   To edit the AutoShape, select the AutoShape, and then use the keyboard to choose AutoShape on the Format menu. Select the options you 
want on the available tabs. 

Insert a text box by using the keyboard 

1. Use the keyboard to select Text Box on the Insert menu.  
2. Use the right arrow key to open the submenu, select either Horizontal or Vertical, and then press CTRL+ENTER.  
3. Type the text you want in the text box (text box: A movable, resizable container for text or graphics. Use text boxes to position several blocks of 

text on a page or to give text a different orientation from other text in the document.).  
4. When you are finished typing and want to switch back to editing text in your document, press SHIFT+F10, choose Exit Edit Text on the 

shortcut menu (shortcut menu: A menu that shows a list of commands relevant to a particular item. To display a shortcut menu, right-click an 
item or press SHIFT+F10.), and then press ESC.  

 NOTE   To format the text box (add a fill color or change the size, for example), select the text box, choose Text Box on the Format menu, and then 
select the options you want on the available tabs. 

Insert a WordArt drawing object by using the keyboard 

1. Use the keyboard to choose WordArt (Insert menu, Picture submenu).  
2. Use the arrow keys to select the WordArt (WordArt: Text objects you create with ready-made effects to which you can apply additional 

formatting options.) style you want, and then press ENTER.  
3. Type the text you want, and then use the TAB key to select other options in the dialog box.  
4. Press ENTER to insert the WordArt drawing object (drawing object: Any graphic you draw or insert, which can be changed and enhanced. 

Drawing objects include AutoShapes, curves, lines, and WordArt.).  

 NOTE   To edit the WordArt drawing object, select the object, choose WordArt on the Format menu, and then select the options you want on the 
available tabs. 

Select a drawing object by using the keyboard 

If the insertion point is within text in your document, do the following: 

Apply the Heading 1 style. ALT+CTRL+1 

Apply the Heading 2 style. ALT+CTRL+2 

Apply the Heading 3 style. ALT+CTRL+3 

Apply the List style. CTRL+SHIFT+L 
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1. Press F10 to make the menu bar (menu bar: The horizontal bar below the title bar that contains the names of menus. A menu bar can be the 
built-in menu bar or a custom menu bar.) active.  

2. Press CTRL+TAB until the Drawing toolbar is active.  

3. Press the RIGHT ARROW key to choose Select Objects .  
4. Press CTRL+ENTER to select the first drawing object (drawing object: Any graphic you draw or insert, which can be changed and enhanced. 

Drawing objects include AutoShapes, curves, lines, and WordArt.).  
5. Press the TAB key to cycle forward (or SHIFT+TAB to cycle backward) through the objects until sizing handles appear on the object you want to 

select.  

If the insertion point is within text in a drawing object, do the following: 

1. Press SHIFT+F10, and then use the keyboard to choose Exit Edit Text on the shortcut menu.  
2. Press the TAB key to cycle forward (or SHIFT+TAB to cycle backward) through the objects until sizing handles appear on the object you want to 

select.  

 NOTE   To switch from selecting objects back to editing text in your document, press ESC. 

Editing drawing objects 

Rotate a drawing object by using the keyboard 

1. Select the drawing object (drawing object: Any graphic you draw or insert, which can be changed and enhanced. Drawing objects include 
AutoShapes, curves, lines, and WordArt.) you want to rotate.  

2. Use the keyboard to choose the command for the type of object you selected — for example, on the Format menu, choose AutoShape or 
Text Box — and then select the Size tab.  

3. Under Size and rotate, use the TAB key to select Rotation, and then type the amount of rotation you want.  

Change the position of a drawing object on a page by using the keyboard 

1. Select the drawing object (drawing object: Any graphic you draw or insert, which can be changed and enhanced. Drawing objects include 
AutoShapes, curves, lines, and WordArt.) you want to change.  

2. Use the keyboard to choose the command for the type of object you selected — for example, on the Format menu, choose AutoShape or 
Text Box — and then select the Layout tab.  

3. Select the options you want.  

Tip 

You can nudge the selected object up, down, left, or right by holding down CTRL and pressing arrow keys. 

Change the size of a drawing object by using the keyboard 

1. Select the drawing object (drawing object: Any graphic you draw or insert, which can be changed and enhanced. Drawing objects include 
AutoShapes, curves, lines, and WordArt.) you want to change.  

2. Use the keyboard to choose the command for the type of object you selected — for example, on the Format menu, choose AutoShape or 
Text Box — and then select the Size tab.  

3. Select the options you want.  

Copy the attributes of a drawing object by using the keyboard 

1. Select the drawing object (drawing object: Any graphic you draw or insert, which can be changed and enhanced. Drawing objects include 
AutoShapes, curves, lines, and WordArt.) with the attributes you want to copy. 

If you select an AutoShape (AutoShapes: A group of ready-made shapes that includes basic shapes, such as rectangles and circles, plus a 
variety of lines and connectors, block arrows, flowchart symbols, stars and banners, and callouts.) with attached text, you copy the look and 
style of the text as well as the attributes of the AutoShape. 

2. Press CTRL+SHIFT+C to copy the object attributes.  
3. Press the TAB key or SHIFT+TAB to select the object you want to copy the attributes to.  
4. Press CTRL+SHIFT+V.  

Mail merge and fields 

Performing a mail merge 
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 NOTE   You must start the Mail Merge task pane (Tools menu, Letters and Mailings command, Mail Merge subcommand) before you can use 
these commands. 

Working with fields 

Key combinations 

Function keys 

SHIFT+Function key 

To do this Press

Preview a mail merge. ALT+SHIFT+K 

Merge a document. ALT+SHIFT+N 

Print the merged document. ALT+SHIFT+M 

Edit a mail-merge data document. ALT+SHIFT+E 

Insert a merge field. ALT+SHIFT+F 

To do this Press

Insert a DATE field (field: A set of codes that instructs Microsoft Word to insert text, graphics, page numbers, and other material into 
a document automatically. For example, the DATE field inserts the current date.). 

ALT+SHIFT+D 

Insert a LISTNUM field. ALT+CTRL+L 

Insert a PAGE field. ALT+SHIFT+P 

Insert a TIME field. ALT+SHIFT+T 

Insert an empty field. CTRL+F9 

Update linked information in a Microsoft Word source document. CTRL+SHIFT+F7 

Update selected fields. F9 

Unlink a field. CTRL+SHIFT+F9 

Switch between a selected field code (field code: Placeholder text that shows where specified information from your data source will 
appear; the elements in a field that generate a field's result. The field code includes the field characters, field type, and instructions.) 
and its result (field results: Text or graphics inserted in a document when Microsoft Word carries out a field's instructions. When you 
print the document or hide field codes, the field results replace the field codes.). 

SHIFT+F9 

Switch between all field codes and their results. ALT+F9 

Run GOTOBUTTON or MACROBUTTON from the field that displays the field results. ALT+SHIFT+F9 

Go to the next field. F11 

Go to the previous field. SHIFT+F11 

Lock a field. CTRL+F11 

Unlock a field. CTRL+SHIFT+F11 

To do this Press

Get Help or visit Microsoft Office Online. F1 

Move text or graphics. F2 

Insert an AutoText (AutoText: A storage location for text or graphics you want to use again, such as a standard contract clause or a long 
distribution list. Each selection of text or graphics is recorded as an AutoText entry and is assigned a unique name.) entry (after Microsoft Word 
displays the entry). 

F3 

Repeat the last action. F4 

Choose the Go To command (Edit menu). F5 

Go to the next pane or frame. F6 

Choose the Spelling command (Tools menu). F7 

Extend a selection. F8 

Update selected fields. F9 

Activate the menu bar. F10 

Go to the next field. F11 

Choose the Save As command (File menu). F12 

To do this Press

Start context-sensitive Help or reveal formatting. SHIFT+F1 

Copy text. SHIFT+F2 
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CTRL+Function key 

CTRL+SHIFT+Function key 

ALT+Function key 

ALT+SHIFT+Function key 

Change the case of letters. SHIFT+F3 

Repeat a Find or Go To action. SHIFT+F4 

Move to the last change. SHIFT+F5 

Go to the previous pane or frame. SHIFT+F6 

Choose the Thesaurus command (Tools menu, Language submenu). SHIFT+F7 

Shrink a selection. SHIFT+F8 

Switch between a field code and its result. SHIFT+F9 

Display a shortcut menu. SHIFT+F10 

Go to the previous field. SHIFT+F11 

Choose the Save command (File menu). SHIFT+F12 

To do this Press

Choose the Print Preview command (File menu). CTRL+F2 

Cut to the Spike (Spike: A special AutoText entry that stores multiple deletions. Microsoft Word appends one item to another until you paste 
the contents as a group in a new location in your document. You can also use the Microsoft Office Clipboard to get the same result.). 

CTRL+F3 

Close the window. CTRL+F4 

Restore the document window size (for example, after maximizing it). CTRL+F5 

Go to the next window. CTRL+F6 

Choose the Move command (title bar shortcut menu). CTRL+F7 

Choose the Size command (title bar shortcut menu). CTRL+F8 

Insert an empty field. CTRL+F9 

Maximize the document window. CTRL+F10 

Lock a field. CTRL+F11 

Choose the Open command (File menu). CTRL+F12 

To do this Press

Insert the contents of the Spike (Spike: A special AutoText entry that stores multiple deletions. Microsoft Word appends one item to 
another until you paste the contents as a group in a new location in your document. You can also use the Microsoft Office Clipboard 
to get the same result.). 

CTRL+SHIFT+F3 

Edit a bookmark. CTRL+SHIFT+F5 

Go to the previous window. CTRL+SHIFT+F6 

Update linked information in a Microsoft Word source document. CTRL+SHIFT+F7 

Extend a selection or block (then press an arrow key). CTRL+SHIFT+F8 

Unlink a field. CTRL+SHIFT+F9 

Unlock a field. CTRL+SHIFT+F11 

Choose the Print command (File menu). CTRL+SHIFT+F12 

To do this Press

Go to the next field. ALT+F1 

Create an AutoText (AutoText: A storage location for text or graphics you want to use again, such as a standard contract clause or a long 
distribution list. Each selection of text or graphics is recorded as an AutoText entry and is assigned a unique name.) entry. 

ALT+F3 

Quit Microsoft Word. ALT+F4 

Restore the program window size. ALT+F5 

Move from an open dialog box back to the document for dialog boxes such as Find and Replace that support this behavior. ALT+F6 

Find the next misspelling or grammatical error. The Check spelling as you type check box must be selected (Tools menu, Options dialog 
box, Spelling & Grammar tab). 

ALT+F7 

Run a macro. ALT+F8 

Switch between all field codes and their results. ALT+F9 

Maximize the program window. ALT+F10 

Display Microsoft Visual Basic code. ALT+F11 

Page 15 of 16Microsoft Office Online: Help and How-to: Keyboard shortcuts for Word

10/3/2007http://office.microsoft.com/assistance/hfws.aspx?AssetID=HP051866641033&CTT=1&Origin=EC0...



CTRL+ALT+Function key 

To do this Press

Go to the previous field. ALT+SHIFT+F1 

Choose the Save command (File menu). ALT+SHIFT+F2 

Run GOTOBUTTON or MACROBUTTON from the field that displays the field results. ALT+SHIFT+F9 

Display the menu or message for a smart tag. If more than one smart tag is present, switch to the next smart tag and display its 
menu or message. 

ALT+SHIFT+F10 

Start the Microsoft Script Editor. ALT+SHIFT+F11 

To do this Press

Display Microsoft System Information. CTRL+ALT+F1 

Open command (File menu). CTRL+ALT+F2 

See Also 

 

Was this information helpful? 
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